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PageMaker 4.01 Release Notes

Aldus PageMaker 4.01 for Macintosh computers is an update that provides a number
of feature enhancements, in particular to the long-document features like indexing and
publication booking, as well as compatibility with PageMaker 4.0 for Windows

This document briefly describes feature enhancements that are new with Page-
Maker 4.01 or that are not discussed in the PageMaker 4.0 documentation.  For a more
thorough conceptual description of the features discussed here, refer to the Aldus
PageMaker 4.0 Reference Manual.

Print this document and add it to your PageMaker 4.0 documentation set.

Enhancements to the ‘‘Book—’’ command

Using the ‘‘Book—’’ command from the File menu in PageMaker 4.01, you can:

· Automatically renumber the pages of the publications in a book list

· Copy a book list to all publications in the book so you can print the entire book or
generate a table of contents or index from any publication in the book list

· When printing the book, either use the print settings of the current publication for
all publications in the book list, or retain the print settings of the individual publica-
tions.

Note: If a book list contains publications created using PageMaker 4.0 for Windows,
we recommend that you first convert each publication to PageMaker 4.01.  Then, be-
fore printing or performing any other book operation, re-create the book list in
PageMaker 4.01.

Automatic page-renumbering using the ‘‘Book—’’ command

With the improvements to the Book feature in PageMaker 4.01, you can now have
PageMaker automatically renumber the pages of publications in a book list.  But this
feature is flexible; you can also choose to have page numbering restart with any publi-
cation in a book list.  These enhancements bring changes to the ‘‘Book publication list’’
and ‘‘Page setup’’ dialog boxes.
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After you specify how you want to renumber publications in your book list, Page-
Maker does not  automatically renumber pages until you perform a ‘‘Book operation,’’
such as printing, creating a table of contents, or generating an index.  When you issue
any of these commands, PageMaker follows the specifications you have chosen in the
‘‘Book publication list’’ dialog box.

The new ‘‘Book publication list’’ dialog box displays a series of options for ‘‘Auto
renumbering’’:

· None: Prevents auto renumbering.  Each publication retains the numbering set in
the ‘‘Page setup’’ dialog box.

· Next page: Numbers publications in a book list consecutively.  Therefore, if the
first publication ends on page 132, the second publication starts on 133.

· Next odd page: Numbers book-list publications so that each publication after the
first one begins with an odd-numbered (right-hand) page.  If necessary, PageMaker
creates a blank page at the end of a publication to ensure that the next publication in
the list begins with an odd page number.  For example, whether the first publication
ends on page 9 or 10, the second publication begins on page 11.  If the first publica-
tion has no page 10, PageMaker creates a blank one.

· Next even page: Numbers book-list publications so that each publication after the
first one begins with an even-numbered (left-hand) page.  If necessary, PageMaker
creates a blank page at the end of a publication to ensure that the first page of the
next publication in the list begins with an even page number.  For example, whether
the first publication ends on page 10 or 11, the second publication begins on page
12.  If the first publication has no page 11, PageMaker creates a blank one.

PageMaker’s auto-renumbering feature is flexible, however; you can restart page
numbering with any publication in the book list.  For example, suppose that your book
list is composed of a table of contents publication and several chapter publications.
Let’s further suppose that the pages in the table of contents--the first publication in
the book list--are numbered with lower-case Roman numerals (i, ii, iii) and the first
chapter is to begin on page 1.
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Making sure your publications are in the correct order in the book list, open the first
chapter publication, choose ‘‘Page setup—’’ from the File menu, and click the ‘‘Restart
page numbering’’ option.  When you print or perform some other Book operation like
generating a table of contents or index, auto renumbering restarts with the first chapter.

Note:  Before you perform a Book operation, make sure you have placed a page num-
ber marker (Command + Option + P) somewhere on each of the master pages.

Copying the book publication list

PageMaker stores the book list in the publication where you created it.  You may, how-
ever, want to copy it to the other publications in the book list.  The advantage to doing
so is that you can then perform any Book operation from any open publication in the
list.

Note, however, that this copied list replaces any existing book lists, and that the
current publication cannot be ‘‘Untitled.’’

To copy a book list, first open the publication in which it was created.  Then hold
down Command while selecting ‘‘Book—’’ from the File menu.   PageMaker copies
the book list to each publication listed.

Printing booked publications

When printing booked publications, PageMaker uses the print settings of the current
publication’s ‘‘Print to:’’ dialog box for all publications in the book list.  However, if
the booked publications are unrelated, you may want each publication to use its own
print settings.  For instance, you may have set up a publication for ‘‘Wide’’ rather than
‘‘Tall’’ printing, and another with ‘‘Spot color overlays’’ checked.  To retain each
publication’s print settings when printing, hold down Command when you click
‘‘Print’’ in the ‘‘Print to:’’ dialog box.

Note that auto renumbering is disabled if:

· You are printing to a ‘‘stack face-up’’ printer such as the Apple LaserWriter Plus

· You are using the Apple driver

· You check ‘‘Reverse order’’ in the current publication’s ‘‘Print to:’’ dialog box

To compensate, you simply generate a table of contents or index first, so that pages
are automatically renumbered before you print.  Then, if you have chosen any of the
three options listed above, PageMaker leaves the page numbering unchanged.
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Enhancements to the indexing feature

The enhancements to PageMaker’s indexing feature make it both faster and easier to
use.  They include revisions to three dialog boxes and two new shortcuts:

· Revised ‘‘Add index entry,’’ ‘‘Show index,’’ and ‘‘Select topic’’ dialog boxes

· Automatic formatting of proper names as index entries

· Automatic capitalization of first-level index entries

Note: As a background to this section, please read the article called ‘‘Indexing’’ in the
Aldus PageMaker 4.0 Reference Manual.

The ‘‘Add index entry’’ dialog box

The ‘‘Add index entry’’ dialog box has two main revisions: the ‘‘Add’’ button and the
option of switching between a ‘‘Page reference’’ and a ‘‘Cross reference’’ mode.  Using
the ‘‘Add’’ button, you can create a number of entries without having to close and re-
open the ‘‘Add index entry’’ dialog box.  The two modes, ‘‘Page reference’’ and ‘‘Cross
reference,’’ clarify your indexing options.

When indexing most terms, it is best to create one or more entries of synonymous
terms so that a variety of readers can use different entries to find the same information.
For instance, index references to ‘‘Raisins’’ can be expanded with synonymous entries
like ‘‘Fruit, shriveled’’ or ‘‘Grapes, withered.’’  Clicking ‘‘Add’’ adds each entry to the
index but leaves the dialog box open for you to type other entries.

The revised ‘‘Add index entry’’ dialog box also displays a different set of options
depending on whether you select ‘‘Page reference’’ or ‘‘Cross-reference.’’

When you click ‘‘Page reference,’’ note that the ‘‘Page range’’ options no longer in-
clude ‘‘Cross reference,’’ and that ‘‘Page # override’’ has replaced ‘‘Reference
override.’’  The ‘‘Topic’’ edit boxes are longer, allowing more room to display index
entry text, while the ‘‘Sort’’ edit boxes are correspondingly shorter.
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When you click ‘‘Cross reference,’’ note how the dialog box options change.  The
page range options are replaced with cross-reference options that in PageMaker 4.0
were available only by undocumented keyboard shortcuts:

See [also]: This option is the default for cross references.  In the printed index, the
cross-reference automatically becomes ‘‘See also’’ if the specified topic has a page
reference, and ‘‘See’’ if it does not.  If in the index you wanted readers to look else-
where than the current entry, that entry would not have a page reference. If you
wanted readers to check the current entry as well as the cross-reference, the current
entry would have a page reference, and the cross-reference would have a ‘‘See
also .’’  For example, in the following index and cross-reference topic, there is no
page reference because the topic (‘‘Donkeys’’) was created as a way to guide read-
ers to the cross-reference (‘‘Mules’’):

Donkeys, See Mules

But in this next example, the index topic has a page reference because it is men-
tioned on a specific page in the book, and the cross-reference simply points to the
location of additional pertinent references:

Burros 243-257, See also  Mules

See: Select this option in instances where a topic may have a page reference but
you want to send the reader to the cross reference only.

See also: Select this option when you want readers to look up both the current
topic and the cross-reference topic.

See herein: Select this option when the current, first-level index topic has no page
reference, and you want readers to look up a second or third-level index entry under
the current topic.

See also herein: Select this option when the current, first-level index topic does
have a page reference, but you want readers to also look up a second or third-level
index entry under the current topic.

The ‘‘Select topic’’ and ‘‘Select cross-reference’’ topic dialog boxes

These two dialog boxes, available from the ‘‘Add index entry’’ dialog box, now include
an ‘‘Add’’ button and edit boxes for topics from each of the three index levels.  These
options allow you to add or edit topics that should not have page references and there-
fore do not have index-entry markers.



PageMaker 4.01 Release Notes

6

These features are essential for occasions when you want to refer readers to a col-
lective topic that does not exist in the text.  For example, for readers looking up a
particular Asian author, you might want them to encounter the following entry and
cross-reference in the index:

‘‘Asian authors.  See individual author name.’’

Neither of these entries needs to have a page reference because both help readers
navigate through the index rather than send them to particular pages in the book.

To create these entries, in the ‘‘Select topic’’ dialog box type ‘‘Asian authors’’ in the
‘‘Level 1’’ edit box and click ‘‘Add.’’  ‘‘Asian authors’’ then joins the topic list so that
this text becomes available for other index entries.  Then, while ‘‘Asian authors’’ is se-
lected in the ‘‘Add index entry’’ dialog box, enter ‘‘individual author name’’ in the
‘‘Select cross-reference topic’’ dialog box and click ‘‘Add.’’

The ‘‘Show index’’ dialog box

The ‘‘Show index’’ dialog box now includes an ‘‘Accept’’ button so that you can accept
changes you make to the index without closing the dialog box.  Thus if you make a se-
ries of changes, clicking ‘‘Accept’’ as you go, and then make an error, you can click
‘‘Cancel’’ to undo the error only, without undoing all the changes you made since
opening the dialog box.

Also, note that the ‘‘Add—’’ button in this dialog box has been revised to read ‘‘Add
x-ref—’’ to clarify that this option is for adding a cross reference, not a page reference.

The ‘‘Show index’’ dialog box makes a number of keyboard/mouse combinations
available for deleting and restoring index entries:

Press this To do this

Option + ‘‘Add x-ref—’’ Deletes all cross-references added since you opened the dialog box or
last clicked ‘‘Accept.’’

Option + ‘‘Remove’’ Restores all cross-references added since you opened the dialog box
or last clicked ‘‘Accept.’’

Command + Option Deletes all page references.  To restore them, press Option + ‘‘Remove’’
+ ‘‘Remove’’ or click ‘‘Cancel.’’
Command + Shift Deletes all cross references.  To restore them, press Option + ‘‘Remove’’
+ ‘‘Remove’’ or click ‘‘Cancel.’’
Command + Option Deletes all index entries.  To restore them, press Option + ‘‘Remove’’
+ Shift + ‘‘Remove’’ or click ‘‘Cancel.’’
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Note: To type as little as possible when creating index entries, select topics in the ‘‘Se-
lect topic’’ dialog box rather than typing them.  Using the Promote/Demote button in
the ‘‘Add index entry—’’ dialog box you can change index entry levels, changing a
first-level entry to a second-level entry, for instance, so that you can then bring in a
first-level topic from the ‘‘Select topic’’ dialog box.  To retain the second-level (or
third-level) entry, however, highlight the topic you want in the ‘‘Select topics’’ dialog
box and hold down Command as you click OK.  If you simply click OK, when you re-
turn the ‘‘Add index entry’’ dialog box, the second-level entry disappears.

Automatic formatting of indexed names

With PageMaker 4.01 you can mark an index entry as a proper name: PageMaker then
reverses the word order of the name to format it for the index.  When indexing a name
in either story or layout view, mark the name by highlighting it and pressing Com-
mand + Shift + Z. For instance, if you highlighted ‘‘Leopold Bilgewaters’’ and used
this key combination, PageMaker would automatically create an entry and format it as
‘‘Bilgewaters, Leopold.’’

You can also index and format names of more than one word, but you need to insert
a non-breaking space between words you want PageMaker to treat as one.  For in-
stance, ‘‘Vincent van Gogh’’ should appear in the index as ‘‘van Gogh, Vincent.’’  For
this to occur, PageMaker must treat ‘‘van Gogh’’ as a single word.  Before indexing
this name, replace the normal space between ‘‘van’’ and ‘‘Gogh’’ with a non-breaking
space (Option + spacebar).

Names using more than one word include titles and middle initials, such as ‘‘Col.
Lilith Badgerbaum’’  and ‘‘Millard P. Fern.’’ In these instances, the non-breaking space
goes between ‘‘Col.’’ and ‘‘Lilith’’ and between ‘‘Millard’’ and ‘‘P.’’  PageMaker then in-
dexes these names as:

Badgerbaum, Col. Lilith

Fern, Millard P.

For hyphenated last names, titles that follow the last name, and names containing
apostrophes, do not use a non-breaking space.  PageMaker automatically indexes
‘‘Cecil Natter-Smythe,’’ ‘‘Ezra O’Rourke,’’ and ‘‘Walter Webbley Jr.’’ as:

Natter-Smythe, Cecil

O’Rourke, Ezra

Webbley, Walter Jr.

Note: When a title following a last name is preceded by a comma (Raisa Gorbachev,
Ph.D.), you must index the name by typing it in the ‘‘Add index entry’’ dialog box the
way you want it to appear in the index (Gorbachev, Raisa, Ph.D.)
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Initial caps for index entries

In many indexes, first-level index entries need initial caps.  To avoid retyping initial
caps for each entry, you can have PageMaker do it for you automatically:

1. Immediately before generating the index using the ‘‘Create index—’’ command, choose ‘‘Show in-
dex—’’ from the Options menu to display the ‘‘Show index’’ dialog box.

2. Hold down Command and click ‘‘Next section.’’

The topics listed in the ‘‘Show index’’ dialog box show initial caps.  If you have al-
ready generated and placed the index, choose ‘‘Create index—’’ and place the index
story again to see the initial caps in the index.

If your final index is for a book comprising several publications, you will need to
repeat this procedure for each publication in the book list.  You may also need to re-
peat it if you add new index entries.

Note: To use initial caps for all index levels, hold down Command + Shift when click-
ing ‘‘Next section.’’

Miscellaneous enhancements

In addition to enhancements to the Book and indexing features, PageMaker 4.01 pro-
vides:

· Performance improvements in startup, placing text files, redraw, and book printing

· Improved transfer between Windows and Macintosh versions of PageMaker

· New options for placing DCS files

· New ‘‘Save option’’ in ‘‘Preferences’’ dialog box

· New Smart ASCII filter and APDs

· ‘‘None’’ option for ‘‘Dictionary’’ in the ‘‘Paragraph specifications’’ dialog box

Performance improvements

In certain situations, PageMaker 4.01 runs much faster than PageMaker 4.0.  Below is
a list of the features showing enhanced performance:

· Placing text files is much faster now because PageMaker 4.01 does not report the
character count while importing.

· DCS files for color separations can be placed much more quickly because of the
new option to exclude composite image information.

· If you have a large number of fonts on your system, startup time is considerably re-
duced.

· PageMaker 4.01 saves bitmapped versions of the screen beneath most dialog boxes.
Thus when you close one of these dialog boxes, PageMaker does not need to re-
draw the screen.
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· When printing color separations for Aldus PrePrint, PageMaker grays out the op-
tion to ‘‘Download bit-mapped fonts’’ in the ‘‘PostScript print options’’ dialog box
and unchecks the option to ‘‘Download PostScript fonts.’’   In place of the fonts,
comments are included in the PostScript file to refer to them.  The performance
change is conspicuous in both PageMaker 4.01 and PrePrint: .sep files take far less
time to create, and PrePrint can open files far more quickly.  And without the down-
loaded fonts, the .sep files are considerably smaller.

· Book operations (printing, generating a table of contents or index) are faster.

Converting publications to PageMaker 4.01

Before converting a PageMaker 3.x publication to PageMaker 4.01, perform a global
recomposition.  In PageMaker 3.x, with the pointer tool selected, hold down Option
and choose ‘‘Spacing—’’ from the Type menu.  Then choose ‘‘Save as—’’ from the File
menu.  These steps purge the publication of deleted text and reduce the possibility of
corruption during the conversion.

New options for placing DCS files

If you use Aldus PrePrint to create color separations from your PageMaker publica-
tions, you may frequently place DCS graphic files, which are EPS graphics that
contain color separation files. Besides containing all four color separations, a DCS file
has both a grayscale or color PICT screen version of the image and information for
printing a non-separated (composite) version.

Because DCS files can be quite large and take a long time to place, in PageMaker
4.01 you can place either all or part of a DCS file, depending on whether you want to
print a composite image from PageMaker.

When you place a DCS file, PageMaker displays an alert box offering a choice:
placing the file quickly but excluding the composite-image information, or taking
longer to place but including the composite image.  If you exclude it, PageMaker dis-
plays a screen version of the image but prints only a gray box, for position only.  If
you include it, you can print the composite image from PageMaker, but depending on
the DCS file’s size, placing it can take an undesirable length of time.  We recommend
that you always exclude the composite image unless you need to see it when you print
from PageMaker.

New ‘‘Save option’’ in ‘‘Preferences’’ dialog box

With previous versions of PageMaker, each use of the ‘‘Save’’ command resulted in
mini-saved versions of a publication being saved with the most recent changes.  The
‘‘Save’’ command worked quickly, but tended to enlarge a publication even when you
were not necessarily adding more text or graphics.  ‘‘Save as—,’’ on the other hand,
condensed the publication, preserving only the most recent version.

In PageMaker 4.01, however, the ‘‘Preferences’’ dialog box has a new pair of op-
tions for saving a publication, ‘‘Faster’’ and ‘‘Smaller.’’  With ‘‘Faster’’ (the default)
selected, PageMaker saves publications the way it always has.  But with ‘‘Smaller’’ se-
lected, ‘‘Save’’ works like ‘‘Save as—,’’ except that no confirmation dialog box
appears.  Each use of the ‘‘Save’’ command clears away all deleted text, saving only
the text and graphics you have added or retained from previous versions.  Saving a
publication takes longer when ‘‘Smaller’’ is selected, but larger publications are consid-
erably reduced in size.
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Help button for virus detection

If PageMaker encounters a virus during startup, it displays an alert that says ‘‘Page-
Maker has been modified.’’   In PageMaker 4.01, a Help button has been added to this
alert.  Clicking this button displays a Help screen that provides information about how
to proceed.

New Filter and APDs

PageMaker 4.01 also includes:

· A new ‘‘Smart ASCII’’ filter that accurately translates the PC character set to the
Mac character set.

· New APDs for the Apple Personal LaserWriter as well as for the HP LaserJet IIP,
IID, III, IIID.

Note: We recommend that you have only one set of APDs installed.  If you have
moved Aldus Prep and the APDs folder to the System folder, PageMaker’s installer
creates a new APDs folder in a folder called Aldus in the System folder.  Copy the new
APDs into your existing APDs folder and discard the empty folder.

Dictionary as ‘‘None’’ option

The ‘‘Paragraph specifications’’ dialog box displays a new option in the ‘‘Dictionary’’
pop-up menu: ‘‘None.’’  When you select ‘‘None,’’ PageMaker removes any dictionary
assignment from the selected paragraph; no dictionary is then available for either spell
checking or hyphenation.  Consequently, when you recompose the publication, Page-
Maker does not change the hyphenation in the selected paragraph, and when you run
the spell checker, PageMaker skips that paragraph.

‘‘None’’ can be valuable either when you do not have a dictionary that’s appropriate
for a particular paragraph, or when you have a number of terms, such as acronyms,
that are not in the current dictionary and that you don’t want to add.  Without ‘‘None’’
selected, PageMaker could prompt you to check the spelling of each word in the para-
graph.   And if you have selected ‘‘Manual plus algorithm’’ as your hyphenation
option, PageMaker might hyphenate words incorrectly.
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Previously undocumented features

Because certain features were added to PageMaker 4.0 after its documentation went to
press, they were either incompletely documented or not documented at all.  We de-
scribe two of them here: the Story Import filter and the ‘‘Inline specifications’’ dialog
box.  We also include a list of undocumented keyboard shortcuts.

Importing PageMaker stories

When you install the Story Import filter, the ‘‘Place document’’ dialog box displays all
PageMaker (version 4.0 or higher) publications in the current folder.  Using this filter
you can place one or several PageMaker stories in your currently open publication,
just as you would any other text files.  For text, this feature provides the functional
equivalent of multiple open publications: you can cut or copy text from any publica-
tion and paste it into the current publication.

When you double-click a publication name in the ‘‘Place document’’ dialog box, the
‘‘Story Importer’’ dialog box appears, displaying a list of the stories in the publication
that contain more than 20 characters of text.

· To list stories of fewer than 20 characters, change the number in the ‘‘List only sto-
ries over__characters long’’ edit box to a number smaller than 20, and click the
‘‘Relist’’ button.

· To select multiple stories and place them as one story, hold down Shift and click
each story you want to include.

· To examine the contents of a story, select the story in the list and click ‘‘View.’’  You
can then scroll down and read the entire story.

· To copy a part or all of a selected story, click the ‘‘View’’ button to display it, select
the text you want to copy, and press Command + C.  After closing the ‘‘Place docu-
ment’’ dialog box, you can paste the text into your current publication.

For more information on using the Story importer, click the ‘‘Help’’ button.

Note: The Story importer does not import inline graphics contained in a story you
choose to place.
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‘‘Step-and-repeat’’ power pasting

PageMaker 4.0 and 4.01 have a power-pasting feature (Option + Command + V) that
pastes objects in predetermined positions, automatically.

To use this feature for ‘‘step-and-repeat’’ pasting:

1. Copy the object you want to repeatedly paste, and press Option + Command + V.

The object is pasted directly on top of the original object.

2. Drag the pasted object into position.

3. Press Option + Command + V until you have pasted as many of the objects as you want.

Each of the pasted objects has precisely the same position relative to its predecessor
as the first pasted object has to the original object.

Note: To paste the same object in the same place on several pages, simply change
pages and press Option + Command + V.

The ‘‘Inline specifications’’ dialog box

Because PageMaker treats inline graphics much as it does text, you can display the
‘‘Inline specifications’’ dialog box to adjust both leading and track kerning for selected
inline graphics.

To display the ‘‘Inline specifications’’ dialog box, use the text tool to select one or
more inline graphics, and then choose ‘‘Type specs—’’ from the Type menu.  Make
sure you select only inline graphics (not any surrounding text).  When your selection
includes text, the ‘‘Type specifications’’ dialog box appears instead.

Undocumented keyboard shortcuts

The following section lists keyboard shortcuts that have not been documented else-
where.

· To automatically update all links when a publication is being opened:

In the ‘‘Cannot find’’ dialog box, locate and select the name of the first file you are
prompted to link. Next, hold down Option and click ‘‘Link.’’  PageMaker then up-
dates the other linked files that are located in the same folder as the one you
selected, and that have ‘‘Update automatically’’ checked as a link option.

· To copy linked text and graphics when preparing a publication for remote printing:

Choose ‘‘Save as—’’ from the File menu to display the ‘‘Save publication as’’ dialog
box.  Hold down the Option key; note that the ‘‘Copy linked documents’’ option
changes to ‘‘Copy linked documents for remote printing.’’  Check this option  and
click ‘‘OK.’’ This action copies only those linked files that are stored externally,
such as TIFF files larger than 256K; you save disk space by copying only the files
you need for remote printing.
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· To create a hanging indent on the ‘‘Indents/Tabs’’ ruler:

Hold down Shift and drag the left indent marker (lower triangle) where you want
the left indent to be.  Note that the marker for the first-line indent does not move.  If
you click a tab position at the left indent marker, you can use this setting for either
bulleted or numbered paragraphs by inserting a tab after a bullet character or a
number.

· To diagnose and repair publication damage:

Hold down Shift + Option and choose ‘‘Hyphenation—’’ from the Type menu.
(Make sure the pointer tool is active and nothing is selected on the page.)  This ac-
tion recomposes text by recalculating hyphenation and line lengths.  If your
computer beeps once, it hasn’t identified a problem.  If it beeps twice, it has identi-
fied and corrected a problem.  If it beeps three times, it has identified a problem but
is unable to correct it.  Note that this method will not recognize or correct all pos-
sible forms of publication damage.

· To set all pages to the same page-display size:

Hold down Option and then, from the ‘‘Page’’ menu, select the page-display size
you want all pages in the publication to have.

· To prevent PageMaker from redrawing the page while you’re moving a graphic
with text wrap:

Press the spacebar while dragging or adjusting the graphic or text wrap.  This fea-
ture does not work when you’re using the cropping tool.

· To switch from any tool to the pointer tool and back:

Press Command + spacebar.

· To change all text attributes back to ‘‘Any’’ in the ‘‘Find attributes’’ and ‘‘Change at-
tributes’’ dialog boxes:

Hold down Option and click ‘‘Attributes—’’ in the ‘‘Find’’ or ‘‘Change’’ dialog box.

· To find markers for inline graphic markers or index entries in story view:

Type ^g (for inline graphics) or ^; (for index entries) in the ‘‘Find what’’ edit box in
the ‘‘Find’’ or ‘‘Change’’ dialog box.

· To enlarge the page display beyond standard size on a built-in monitor:

Hold down Command and drag the size box in the lower-right corner of the layout
view window.  This feature works only when the smaller monitor is the startup
monitor.

· To display a list of installed filters:

Hold down Command and choose ‘‘About PageMaker—’’ from the Apple menu.  To
display a list of PageMaker’s creators, hold down Shift instead of Command.

· To enable the numeric keypad:

Press the Caps Lock key or hold down the Option key when typing keypad num-
bers.  In layout view, you can also press the num lock/clear key on the keypad.
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Tips

Using the following tips should help your work with PageMaker go more smoothly.

Working only from a hard disk

Use floppy disks only to store backup files.  Never open and work on a publication on
a floppy disk; PageMaker’s performance is drastically diminished.  Also, always copy
a publication to your hard disk before working on it.  In this way you preserve the
backup copy as well as ensuring peak performance from PageMaker.

Likewise, never save a publication or export a story to a floppy disk.  Doing so may
damage the publication, and the export will take a very long time to complete.  Always
save or export to your hard disk, and then copy the publication or exported file to a
floppy disk for storage.

Improving PageMaker’s performance

The following tips explain ways to reduce startup time as well as the time it takes
PageMaker to redraw the screen:

· Install only the APDs and filters you plan to use frequently.

· Though PageMaker’s startup time has improved markedly on systems where a large
number of fonts have been installed, we recommend that you close unneeded font
suitcases when using Suitcase II or Master Juggler.

· If you are using Adobe Type Manager (ATM), increase the ‘‘RAM cache’’ value to
256K in the Control Panel.  (Use version 2.0 or higher of ATM.)

· Be sparing in your use of small caps and the ‘‘Set width—’’ command.  When pos-
sible, leave character width set to 100% until you are ready to print, and make
character-width adjustments in paragraph style definitions.

· Before editing text in layout view, set the ‘‘Detailed graphics’’ option to ‘‘Gray out’’
in the ‘‘Preferences’’ dialog box.  This display option does not affect printing.

· Before working with graphics, set ‘‘Greek text below__pixels’’ to 9 or higher in the
‘‘Preferences’’ dialog box.

· When inline graphics do not require baseline adjustment or resizing, import them
into story view instead of placing them in layout view.

· Whenever possible, write and edit text in story view rather than layout view.

For more information on optimizing PageMaker’s performance, read the ReadMe
file located in your Aldus PageMaker 4.0 folder.

Positioning a drop shadow automatically

The standard use of the ‘‘Paste’’ command (Command + V) pastes objects at a slight
offset from the original object.  You can often use this offset to position a drop shadow
automatically.

Copy and paste the object you want to shadow, and then choose ‘‘Send to back’’
(Command + B) from the Element menu.  Next, choose the ‘‘Solid’’ fill from the Ele-
ment menu.  The object in back forms a drop shadow at a perfect offset from the
original object.
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Licenses and Trademarks
Aldus, the Aldus logo, and PageMaker are registered trademarks of Aldus Corporation. PostScript, Illustrator, and Type Manager are registered trademarks of Adobe
Systems Inc., and all references to PostScript on the screen or in this guide are references either to the PostScript interpreter or to PostScript language. Apple,
LaserWriter, and Macintosh are registered trademarks and TrueType is trademark of Apple Computer Inc. Windows is a trademark of Microsoft Corporation.
PANTONE®™ is a registered trademark of Pantone, Inc.  All other trademarks are the property of their respective companies.  ™Pantone, Inc.’s check-standard
trademark for color reproduction and color reproduction materials. ‘‘PANTONE Color Computer Graphics.’’ © Pantone, Inc., 1986, 1988.  PANTONE® Computer
Video simulations used in this product may not match PANTONE-identified solid color standards. Use current PANTONE Color Reference Manuals for accurate
color.  Pantone, Inc. is the copyright owner of PANTONE Color Computer Graphics and Software which are licensed to Aldus Corporation to distribute for use only
in combination with Aldus Corporation’s software. PANTONE Color Computer Graphics and Software shall not be copied onto another diskette nor into memory
unless as part of the execution of Aldus Corporation’s software.
APPLE COMPUTER, INC. MAKES NO WARRANTIES, EITHER EXPRESS OR IMPLIED, REGARDING THE ENCLOSED COMPUTER SOFTWARE
PACKAGE, ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT
PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL
RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU HAVE WHICH VARY FROM STATE TO STATE.

Using ‘‘Convert quotes’’ effectively

If you are composing in either layout or story view, you can have PageMaker auto-
matically convert standard quotation marks and apostrophes to typesetters’
equivalents, and double hyphens to em dashes.  The technique described here is faster
than using the ‘‘Change—’’ command to convert them.

Note: Do not use this technique if the story contains inline graphics, or they will be
lost when you reimport the story.

To convert quotation marks, apostrophes, and double hyphens:

1. Click an insertion point in the text, and choose ‘‘Export—’’ from the File menu.

2. In the ‘‘Export’’ dialog box, type a filename, select ‘‘Entire story,’’ and click ‘‘OK.’’

3. Choose ‘‘Select all’’ (Command + A) from the Edit menu, and then choose ‘‘Place—’’ (in layout
view) or ‘‘Import—’’ (in story view).

The ‘‘Place document’’ or ‘‘Import to Story Editor’’ dialog box appears.

4. Check ‘‘Convert quotes’’ and ‘‘Replacing entire story,’’ and click ‘‘OK.’’

The imported version of the story replaces the current version, and PageMaker con-
verts quotation marks, apostrophes, and double hyphens.


